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E sthetic rehabilitations always start with a 
proper diagnostic effort ,1–5 traditionally a 
two-step approach including a diagnostic 

wax-up and the corresponding provisional restoration 
(to be evaluated in vivo). Anterior bonded restorations 
call for a specific approach. The additive diagnostic 
wax-up and the acrylic mock-up can be used as tools 
for molding direct restorations, to guide tooth prepa-
ration procedures, and to “biocopy” semi-(in)direct 
restorations.6 This approach is intrinsically objective 
and simple and allows significant economy of tooth 
substrate while generating an invaluable amount of 
diagnostic information for design and prognosis of the 
final restoration. A close, interactive relationship with 
the dental laboratory is required for this approach, 
especially for the most complex indirect restorations. 

In recent years, a new layer has been added to this 
process in the form of digital simulations to initiate the 
diagnostic approach. Original 2D digital designs were 
the logical evolution of previous analog tracings, and 
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the exceptional computing power of today combined 
with the accessibility of digital photography and sophis-
ticated photo editing software not only provide guidance 
in the treatment planning and diagnostic approach but 
also help to improve patient communication and moti-
vate the patient.7–9 Various forms of digital simulation 
are possible depending on the skills of the operator and 
the complexity of the software being used, ranging from 
comprehensive 3D approaches7,10–12 such as Digital Smile 
Design (DSD),7 which comprises specific steps, the use of 
online services, and printing of 3D models, to the more 
basic Photoshop Smile Design (PSD), which makes use 
of a few tools in Adobe Photoshop software.8 While DSD 
uses 3D templates of existing dentitions, PSD is only 
2D and relies on the existing knowledge of the oper-
ator. However, currently, the 2D approach provides a 
higher-quality image that appears more realistic for the 
patient to absorb.

This article presents an evolution of the PSD approach 
known as Dentofacial Digital Diagnostic (Triple D). With this 
protocol, a limited number of high-resolution photos and 
standard imaging software are used to generate realistic 
images of the potential esthetic therapeutic outcomes. 
A specific head posture and novel dentofacial landmarks 
are proposed. The length and position of anterior teeth is 
first determined on a portrait photo in rest position and 
then transferred to a corresponding image showing the 
patient’s smile (teeth visible but not touching lower lip) and 
then to the photo of the patient with lip retractors. Standard-
ized images > 24 MP (megapixels) are necessary for use in 
the photo editing software. Depending on the case, the 
existing teeth are either corrected/modified or over-
laid with teeth from a library of natural dentitions. The 
high resolution and standardization of the process 
allows fine editing of tooth details at high magnifi-
cation while also enabling the operator to zoom out 
to evaluate edits and gestalt within the frame of the 
portrait. This allows a global representation of the 
esthetic treatment proposal with limited perceptual 
distortion. The patient’s perception and desires can 
be assessed with different proposals to deter-
mine the most appropriate design. Additional 
retracted smile images can be used to provide 
detailed information about discrepancies 
in the soft tissue morphology and potential 
corrections by the periodontist. Preopera-
tive and edited images are finally assembled, 
compared, and discussed with the patient 

using a presentation software. This whole process should 
prepare and help the operator read the patient’s expecta-
tions and desires before starting the diagnostic wax-up/
mock-up/provisional stage while significantly improving 
mutual confidence with the patient.

Step-by-Step Triple D

1. Personality patient portrait

It is important to capture the personality and social 
context of the patient. This will help in the definition of the 
project. An informal shot with the patient in a relaxed and 
casual stance using the setup described hereafter (studio 
conditions, camera settings, etc) can be used (Fig 1), but 

FIG 1   
Personality shot. The 
patient is encouraged to 
express a natural 
stance. Note the 
patient’s subdued  
smile, revealing  
an introvert  
character.
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the patient can also bring their own images to provide a 
glimpse of their social environment. 

2. High-definition patient portraits

For these working shots, the patient is given the follow-
ing instructions:

•  The hair must be tied back so the ears are clearly visible.
•  The skin and lips must not be too glossy (matte foun-

dation and lip gloss) to avoid strong specular reflection, 
which could cause distraction.

•  The neck must be visible all the way to the shoulder 
transition (ie, no turtleneck or halter tops should be 
worn).

•  The patient must stand upright at a designated point 
marked on the floor (see Fig 2).

The setup for portrait photos includes the following:

•  A white matte background wall or screen
•  Two strobe lights (Hensel Integra Pro 500W monolight) 

directly illuminating the wall or screen
•  Two strobe lights (same as above) with a diffusing soft-

box (minimum 1 × 2 ft) to illuminate the patient
•  A dark ceiling above the patient’s head if possible (see 

Fig 3)

If the suggested space between the object, operator, 
and the wall cannot be obtained, it is recommended to 
reduce the intensity of the back strobe lights and the 
direct lights until a satisfactory exposure is achieved. The 
camera settings may also need to be slightly altered. The 
strobe lights are paired with a transmitter to synchronize 
with the camera. It is recommended to set the power of 
indirect light (against the wall) at no more than 70% 
and the power of the direct light (with softbox) at 85%. 
A possible setup with the exact positioning of each 
element is depicted in Figs 2 and 3.

The camera settings must be as follows:

•  Manual mode 
•  f-stop 9 to 11 (depending on skin tone, hair color, cloth-

ing, etc) 
•  Shutter speed 1/60 s
•  White balance 5,560 K
•  ISO 100
•  Minimum resolution of 24 MP, preferably including 

RAW data for professional-level editing
•  Lenses with 85 to 105 mm in focal length with full-

frame sensors to avoid distortion of facial features
•  Autofocus in single shot (AF-S) with the smallest area 

(pinpoint)

FIG 2  Two strobe lights are placed symmetrically 2 ft from the white matte wall 
and 5 ft apart and set at  70% power. The patient stands about 6 ft from the wall. 
Two additional strobe lights with softbox are placed 6 ft from the patient and set  
at 85% power.

FIG 3  Photograph showing studio setup. *A light-absorbing  
panel (black) was added to limit any reflections on the hair 
and increase contrast with the background (this is especially 
important in cases of light hair color).

Manual, ISO 100, WB 5560 K, Autofocus, f/9–f/11, 1/60 s

Magne et al
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Finally, each portrait needs to be taken with a standardized head posture, framing, 
and focus point (see Figs 2 and 3), preferably in landscape format to facilitate horizontal 
alignment with the eyes: 

• The patient’s face and shoulders must be parallel to the camera sensor and strobe 
light planes.

• Both ears must be equally visible.
• The bipupillary line must be as horizontal as possible.
• The otobasion superior (soft  tissue point on the upper outer rim of the ear where it 

unites with the skin of the head) must line up horizontally with the exocanthion (soft  
tissue point located at the outer commissure of each eye).

• For the at-rest photo, the focus point must be off set to the eye; for the smile and 
retracted views, it must be on the teeth (central incisors).

• The neck and shoulders must be visible.

A series of images (three to four per position) is generated as follows:

1. At-rest position, with lips closed or almost touching (Fig 4). 
2. At various spontaneous smiles (Fig 5). Instruct or guide the patient to smile while 

avoiding contact of the central incisors with the lower lip. The images will not be 
usable if maxillary teeth are touching the lip or even hidden by the lower lip (Fig 6).  
For this reason, a series of images at various openings will provide a range to choose 
the best shot between a spontaneous smile and one with forced opening.

3. With lip retractors (Fig 7). 

Each image is carefully verified for accuracy and to make sure that proper data has 
been collected.

FIGS 4–7
The four raw images to 
be potentially used for 
the Digital Dentofacial 
Diagnostic. Note that 
Fig 6 will not be usable 
because of the contact 
between the teeth and 
the lower lip.
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3. Initial image enhancement 

All images are transferred to the computer and archived in a folder labeled “origi-
nal_raw” or something similar. The three most appropriate photos are selected (rest, 
smile, and retracted) and duplicated in a folder labeled “selected.” Camera brands 
each have their own proprietary RAW format (eg, NEF for Nikon Electronic Format, 
CRW for Canon Raw Format) that requires conversion using a free converter (eg, 
Adobe Camera Raw for export to Adobe Photoshop). The RAW formats are uncom-
pressed and unprocessed files that store the largest amount of information. Aft er 
editing, RAW files can be converted and compressed to other formats like JPEG or 
PNG for use in other applications. At this stage, the RAW image will be enhanced in 
Adobe Photoshop in the following order:

1. Crop tool: Crop and rotate the image to obtain the horizontal bipupillary line and 
free space next to shoulders. Rotation is an essential tool and reveals a grid that 
can be used to align the reflections of the soft boxes with one of the horizontal 
lines (Fig 8). 

2. Optional: Quick selection of the white background can be made to increase the 
whiteness in case of shadows (especially in the corner of the image). There are 
various ways to blend the background. This additional step will allow smoother 
transitions when comparing subsequent images using the presentation soft ware. 
Hair around the neck or other hair flashes can be easily removed with the Brush tool 
by selecting the shade of the background and using decreasing sizes and strength 
of brush strokes while approaching the neckline (Figs 9 and 10).
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3.  Curves/sharpen: Several adjustments are possible, 
but the all-in-one tool is the Curves adjustment (by 
moving some points in the tonal range graph; Fig 11). 
The goal is to improve the contrast, exposure, and 
color according to one’s taste. The image can also 
be sharpened (increase of contrast at image edges) 
using the Sharpen filter, Unsharp Mask.

4.  Spot healing: In this last step, dust from the camera 
sensor and undesired imperfections (acne, blemishes, 

pimples, etc) can be removed with the Spot Healing 
tool. The best results are obtained when using the 
smallest brush possible. The goal is to avoid the 
patient focusing on unpleasant features while evaluat-
ing the images.

5.  Save in the photo editing software format (eg, PSD 
for Adobe Photoshop) and make an additional JPEG 
or PNG version to export the image for the next step 
(Fig 12).

FIG 8   
Horizontal 
alignment is 
facilitated by the 
reflection of the 
softboxes in the 
eyes (red arrows). 
Note also 
otobasion superior 
is aligned with 
exocanthion (blue 
arrows). 

FIG 9   
Painting the 
background (Brush 
tool) to eliminate 
hair flashes. 
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RAW

FIG 12  
Clean high-resolution image saved as PSD 

and ready for export in presentation 
software. Preprocessing RAW image 

adjacent for comparison.

FIG 10  
Clean image with 

white background. 

FIG 11  
A wide range of 
adjustments of 
brightness and 
contrast can be 

made by slightly 
moving the central 

point of the tonal 
range graph, 

followed by 
increasing 

sharpness with the 
filter Unsharp 

Mask. 
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4. �Dentofacial relationships  
and landmarks

The clean images (rest and smile) are now ready to start 
the dentofacial analysis. First, the rest image is imported 
into a presentation software (eg, Apple Keynote, Micro-
soft PowerPoint) to identify landmarks that will later be 
used to reveal facial characteristics and define the place-
ment and position of anterior teeth. The following land-
marks are obtained from the rest image (Fig 13):

•  Median rectangle with upper corner at the center of 
the outer flash reflection in the iris and lower edge at 
the level of the labial commissures.

•  Vertical midline at the center of the median rectangle. 
These first two landmarks provide facial centering and 
horizontal alignment.

•  Vertical line through endocanthion. Where this line 
crosses the rectangle base is the mesiodistal position 
of the canine.

•  Oblique line from the mesial outline of the iris to the 
ala naris. This is the inclination of the canines.

13 14

▶▶▶
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FIGS 13–15  Dentofacial references obtained from the rest portrait are transferred to the smile portrait using the irises as a reference. Additional 
references are drawn onto the smile portrait to find the incisal edge position of the lateral incisor (22 mm from estimated vestibule) and central 
incisor (2.0 to 2.5 mm below the lateral incisor). The image is then magnified within the presentation software to work on the tooth design.

•  A copy of the same oblique line is placed at the mesial 
outline of the pupil and should roughly meet the 
rectangle base at the same point as the endocanthion 
vertical line.

•  Horizontal line at the level of the buccal vestibule, 
which can be approximated by the lower edge of the 
ala naris. This reference line cannot be established 
on the smile portrait due to the elevation of the soft 
tissue during smiling.

Using the bipupillary distance and outlines as a refer-
ence, all landmarks above are transferred to the smile 
image (Fig 14) and calibrated for size (using the pupils). 
Additional landmarks are then drawn in this image:

15

•  The circle of the iris has an average 11-mm diameter 
(adult) and is duplicated to create a 22-mm reference, 
then aligned with the horizontal reference of the vesti-
bule. A digital ruler is brought to the picture and calibrated 
using the 22-mm reference from the irises. Another more 
precise but less practical way of calibrating the ruler is 
to measure a fixed distance (eg, distal outline of the left 
central incisor to the distal outline of the right central 
incisor) on the patient or on casts.

•  The 22-mm mark below the vestibule (using the 
lower edge of the ala naris from the rest photo) is the 
horizontal reference for placement of the lateral incisor 
edge (see Fig 14).

•  The same ruler is then used to place a horizontal line 
1.5 to 2.0 mm below the previous one, which is the 
reference for the length of the central incisor (Fig 15).
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FIG 16   
Detailed view of the 
dentofacial mask by 
author MM. 

FIG 17  A library of existing teeth from a retracted smile was chosen according to the patient’s desire/character/personality. Each tooth shape 
was saved as a separate file.

Figures 16 and 17 show the detailed dentofacial mask performed in this case and the 
library of existing teeth selected for the digital design. 
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5. Image editing

The smile image with all lines completed is magnified within 
the presentation soft ware to start the new design (Fig 18), 
which can be achieved using three diff erent techniques, 
depending on the case complexity as well as the skills of 
the operator with Photoshop soft ware and especially their 
knowledge of morphology and esthetic principles.

Library approach
The library method is chosen when multiple existing 
teeth need major modifications (large unesthetic resto-
rations, severe wear, etc). Tooth surfaces from a data-
base of natural teeth (see Fig 17) are imported from 
retracted smiles, ideally natural dentitions provided by 
family peers or other dentitions preferred by the patient. 
A realistic simulation is only possible with a library orig-
inally photographed with the same sett ing used for the 
portrait images of the patient (lens, strobe light arrange-
ment, distances, etc). Within the presentation soft ware, 
the landmarks are used to place each tooth surface 
(Figs 19 and 20). Mirror copies of the shapes are used 
on the contralateral side, and an arrangement can be 
easily obtained. Finally, all landmarks are removed, and 
a facial mask without teeth (Fig 21) is imported to cover 
the surfaces with the lips (Fig 22).

FIG 18 Magnified smile 
with all landmarks. 

FIGS 19/20 Libraries of 
tooth surfaces are imported 
and placed one by one (mirror 
replicas can be used to complete 
the contralateral side). 

FIGS 21/22 A facial mask 
obtained by deleting the teeth 
from within the lips is then over-
laid to hide the cervical excess 
from imported shapes.

18

19 20

21

22
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The resulting smile image is saved as a TIFF and finally 
exported to Photoshop to be refined with various tools, 
mostly the Brush tool to outline the incisal edges (Fig 
23) and blend interdental spaces and gingiva (Fig 24). 
The outline of each surface can be blended using the 
Smudge tool to soften the transitions. The final image is 
finally completed by brushing the shadow of the upper 
lip at the cervical aspect of each tooth (Fig 25). This 
file can be imported in the presentation software and 
overlapped with the initial portrait to generate the final 
design (Fig 26).

Using again the irises as a reference, it is also possi-
ble to reposition the new shapes on the portrait with 
retracted smile. This will provide preliminary guidelines 

FIGS 23–25  The magnified file with the new tooth shapes and lips is exported to Adobe Photoshop to refine the incisal edges and blend and 
integrate the outline of each tooth (interdental and gingival transitions).  A more natural appearance is obtained by painting a light shadow of 
the upper lip onto the teeth and gingiva. 

FIG 26   
The final portrait is 
obtained by replacing 
the original smile 
with the edited one 
within the presenta-
tion software.
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FIGS 27–30  
Repositioning of the 

modified library tooth 
shapes within the retracted 

smile revealed significant 
discrepancies of the 

gingival contours. 

for periodontal surgery (Figs 27 to 30). These markings 
can be meticulously utilized by a periodontist to delin-
eate the gingival line during surgery. Each modification 
can be calibrated using a digital ruler to provide precise 

measurements of the discrepancies between the current 
gingival line and the intended outcome of the Triple D. 
This case was planned and restored accordingly using  
12 bonded porcelain restorations (Figs 31 to 34).
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FIGS 31/32   
The treatment of this specific case required periodontal surgery, 
which was calibrated by the Triple D and consecutive wax-up/
mock-up. Bonded porcelain restorations were used for final 
restoration (Creation CC on refractory die technique). 

FIGS 33/34  The final restoration is well integrated within the 
face and the soft tissues.
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Modification approach
The modification method is best for cases that require 
minor modifications, especially when the existing teeth 
already have adequate structure, color, and surface tex-
ture. Figures 35 to 44 illustrate the sequencing of this 
approach:

1.  �It always starts with the lateral incisor edge based on the 
22-mm rule described previously. If only slight modifi-
cations are needed, just the Liquify tool (in Filters menu, 
Forward Wrap tool) is necessary (Figs 35 and 36).

2.  �A duplicate background layer is created (Duplicate 
Layer in Layer menu; Fig 37) before doing further 
transformations. This will ensure that no blank nega-
tive spaces appear after transforming the teeth.

3.  �Continuing with the central incisors, tooth outlines are 
selected with the Magnetic Lasso tool and then edited 
with Free Transform (in Edit menu; Fig 38) to increase 
length and obtain ~1.5 mm of difference in length with 
the lateral incisor (up to 2 mm depending on the wear 
status). If no further Free Transform is needed, layers can 
be merged by using the Layer menu, Flatten Image.

FIGS 35/36  The lateral incisor edge was identified at 22 mm from the ala naris (rest image), and the Liquify tool (in Filters menu, Forward Wrap 
tool) was used to edit the lateral incisors.

FIG 37  Duplicate Layer in Layer menu is then applied to fill the 
background before further transformations. 

FIG 38  The central incisor outlines are selected (Magnetic Lasso  
tool), and Free Transform (in Edit menu) is used to obtain an average  
of 1.5 mm of length difference with the lateral incisor. 

22 mm 22 mm

1.5 mm
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4.  One central incisor outline is first modified using the 
rectangle selection before opening the Liquify tool (Fig 
39) in order to close the contact with the lateral incisors 
without modifying the latter. Further use of the Liquify 
tool allows refinement of the cervical shape (Fig 40).

5.  The other central incisor is made by selecting the 
first one (Magnetic Lasso tool), copying and pasting 
it, then mirroring the selection with Flip Horizontal 
(in Edit, Transform menu; Fig 41). It is moved into the 
ideal position with the Move tool. Once in place, the 

image is flattened again and cleaned with the Brush 
and Spot Healing Brush tools in order to blend the 
edges of the copied tooth (Fig 42).

6.  Finally, the canines are treated exactly as the central 
incisors. The left canine is modified, copied, and pasted 
using mirroring to obtain the right canine (Fig 43). 

7.  The final image is cleaned using previously 
mentioned tools to improve blending, refine the 
shapes, and remove symmetric elements created by 
the mirroring steps (Fig 44).

FIG 42  Once in position, the image is flattened again and cleaned with 
the usual tools (Brush tool, Spot Healing Brush, etc) to blend the edges 
of the copied tooth. 

FIG 43  The left canine is modified and then copied and mirrored to 
obtain the right canine.

FIG 44  Final clean image (blended, shapes refined, and symmetric 
elements removed).

FIG 41  The Magnetic Lasso tool is used to copy and paste the edited central 
incisor and mirror the selection (Flip Horizontal in Edit, Transform menu).

FIGS 39/40  
The most appealing central incisor is 

selected as a rectangle before opening 
the Liquify tool and optimizing the shape 

with the Forward Wrap tool. 39 40
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Mixed approach
While this article illustrated two cases using the library 
approach and the modification approach individually, these 
approaches can certainly be combined whenever neces-
sary to maximize the esthetic potential.

Expressions of the Smile 

For optimal interaction with the patient, it is fundamen-
tal to understand the two major types of smile expres-
sion and all the variations in between (Fig 45).

The stereotypical smile expression 

The stereotypical smile (see Fig 45, left) is perfectly 
symmetric, static, dull, and lacks natural character. Some 
call it the “classic Hollywood smile” or the “perfect smile.” 
It is characterized by the following:

•  Smaller, more regular, and similar groups of teeth 
(central incisor, lateral incisor, canine)

•  Maximally reduced incisal embrasures
•  Limited or absent length shift between central and 

lateral incisors 
•  Buccal alignment without steps between tooth groups
•  Flat smile line (compared to the lower lip line)

The general feeling associated with this design is a 
heavy visual weight ultimately justifying a reduced tooth 
size with an aged/worn connotation.

The natural smile expression 

The natural smile (see Fig 45, right) is more animated, 
dynamic, and associated with character. Some call it the 
“European smile.” Such a smile displays teeth firmly rooted 
in their alveolar ridge, with dynamism but stability. It is char-
acterized by the following:  

•  Distinct groups of teeth with contrasts similar to the 
different but complementary elements of a symphony

•  Sharp but delicate incisal embrasures
•  Length shift between central and lateral incisors
•  Often buccally inset or rotated lateral incisors
•  Incisal edges and canine tips following the lower lip line

The general feeling associated with this design is 
harmony, youth/health, and light visual weight, ulti-
mately justifying, especially in women, predominant 
central incisors and a voluptuous connotation. In this 
design, each tooth provides a specific expression/mean-
ing: patient personality (central incisors), fantasy/jovial-
ity (lateral incisors), and masculinity/potency (canines).

Presentation and Discussion with 
the Patient	

All media created during the Triple D can be imported 
into a presentation software (Keynote, PowerPoint, etc). 
Because all images can be superimposed, the patient 

FIG 45  Direct comparison of the so-called “classic” (left) and “natural” (right) smile designs. Both images were generated digitally.
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can browse through consecutive images and watch 
them like a “movie” of the steps involved. Looking at 
the simulation, an individual is more prone to explore 
surgical and orthodontic options when it appears that 
teeth are extremely out of position or the gingival display 
requires adjustment.

When patients have difficulty expressing their desire 
and mental image of the expected smile, it is useful to 
present simultaneously two different designs—one 
natural and one more artificial. The individual response 
will ultimately guide the designer toward the most 
appropriate type of design. For optimal communica-
tion, it is best to avoid any intermediaries between the 
designer and the patient.

Conclusion

The Dentofacial Digital Diagnostic (Triple D) uses a 
maximum of three high-resolution photos, specific 
head posture, and novel dentofacial landmarks in an 
image editing software to provide realistic images of 
the potential esthetic therapeutic outcomes. Because 
the modified images include the whole face, all edits 
and gestalt can be evaluated within the frame of the 
portrait as well as detailed information about discrep-
ancies in the soft tissue morphology. Different proposals 
can be used to determine the most appropriate design, 
and all documents, once assembled, can be compared 
and discussed with the patient using a presentation 
software. Through this 2D blueprint, a unified target 
is created for the dentist, involved specialists, and the 
technician to be able to understand the patient’s expec-
tations and desires before starting the 3D process (diag-
nostic wax-up/mock-up/provisionals).
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